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Validity
This manual covers the following product(s):

� NodeManager type S111SX version 2.6

Compatibility
The Ernitec NodeManager is compatible with the following equipment:

� Matrix X, all types.
� SYSTEM X Telemetry Receivers.
� Keyboard X, all types.
� LON® Box X, all types.
� VSX-704 Video Server.

Operation
The NodeManager software is used to configure the LONWORKS® communication network for
SYSTEM X components (referred to as Nodes), and to program all settings for the complete
SYSTEM X application.

Computer Requirements
These are the minimum computer requirements for the NodeManager software.

� Pentium® 4, or equivalent.
� Windows 2000/XP *) Operating System (only tested with English versions).
� Internet Explorer version 5.5, or later, installed (included on CD-ROM).
� Video Card capable of min. 800x600 resolution (1024x768 recommended).
� 256 Mb RAM.
� 200Mb free Hard Disk space (depends on size of installation).
� CD ROM Drive.
� Windows compatible Pointing Device.
� SLTA-10, PCC-10 (or similar) Network Adapter for LON®.

*) You may experience problems when running NodeManager under Windows 2000/XP. This is
due to a bug in Windows 2000/XP, please download latest Win2000/XP Service Pack from
www.windowsupdate.com, to fix it.

CD Content
The following is included on the SYSTEM X installation CD.

� NodeManager, Ernitec LON Setup Program.
� SYSTEM X manuals, in PDF file format.
� Acrobat PDF Reader, version 5.0
� Internet Explorer, version 5.5 (required)

Trademarks
Echelon, LON and LONWORKS are trademarks of Echelon Corporation registered in the
United States and other countries.

All other brand and product names are trademarks of their respective companies.

17-12-2004
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LON® Network Installation

All SYSTEM X components (nodes) are connected together in a common LONWORKS®

communication network.

There are two ways of building a LONWORKS® network: Free topology or bus topology.

Free Topology
In a free topology network, there are no demands as to how the cables are routed between the
nodes. It can be point-to-point, bus, star, tree, or a mixture.

Free Topology

Termination

When using free topology, the maximum cable length in one segment is approx. 500 meters,
and is calculated adding together all cables used. The maximum number of nodes in one
segment is 64. If more that 500 meters, or more than 64 nodes, is required, two or more
network segments can be made, using a LON repeater between each segment.

Bus Topology
In a bus topology network, all nodes are connected on a bus. Cable stubs can be used to
connect the individual nodes to the bus, as long as the length of the stub is maximum 3
meters.

The advantage of bus topology, is that the cable length can be longer than when using free
topology. This can be useful e.g. when making network connection to remote PTZ cameras.

Bus Topology

Termination Termination

The maximum number of nodes on one bus is 64. Maximum length of the network bus
depends on the type of cable used. If more nodes, and/or longer cable length, is required, two
or more network segments can be made, using a LON repeater between each segment.

S Y S E M
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Repeater
If the maximum numbers of nodes (max. 64) or total cable distance are exceeded, a Repeater
can be added to interconnect two or more network segments.

A repeater can also be used to convert from a free topology network to a bus topology
network. This can be useful when e.g. making network connection to remote PTZ cameras.

Note that only one Repeater should be placed in series between any two nodes in a segment

Bus Topology

Termination Termination

Free Topology
Termination

3-way
Repeater

Free Topology
Termination

Termination
Each network segment require termination for proper data transmission performance. The type
of termination varies depending on whether Free topology or Bus topology is used.

In a free topology network segment, only one termination is required and may be placed
anywhere on the network. The termination resistor should be a 52 ohm, 1/4W type.

In a bus topology network segment, two terminations are required, one at each end of the bus.
The termination resistors should each be a 105 ohm, 1/4W type.

Termination resistors are easily fitted using the LON® connectors on the SYSTEM X units.

12V~
50Hz

LON

LON® cable

Termination
resistor 

S Y S E M
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LON® Network Cables

The following five cable types have been validated by Echelon®, but other cable types may be
used provided they have specifications similar to the ones listed below.

Validated cables:

Yes0,8mm20,4AWGJ-Y(St)Y3) 2x2x0.8

Both0,65mm22AWGLevel IV2) cable

No1,3mm16AWGBelden 85102 (Tefzel jacket) or equivalent cable

No1,3mm16AWGBelden 8471 (PVC jacket) or equivalent cable

Both0,5mm24AWGTIA/EIA 568A1) Category 5 cable

Shielded4)DiameterAWGCable type

1) Any cable that meets the TIA/EIA 568A standard, is suitable for LON® Networks.
2) Standard originally specified by the National Electrical Manufacturers Association (NEMA).
3) The J-Y(St)Y cable is normally only available in Europe.
4) In order to comply with EMC/EMI standard EN 50130-4, shielded cable must be used.

Examples on TIA/EIA 568A Category 5 cables:

Yes0,5mm24AWGBelden 1668A

Yes0,5mm24AWGBelden 1633A

Yes0,5mm24AWGBelden 1624

ShieldedDiameterAWGCable type

Examples on NEMA Level IV cables:

Yes0,65mm22AWGAnixter 9F220154

ShieldedDiameterAWGCable type

Examples on J-Y(St)Y 2x2x0.8 cables:

Yes0,8mm20,4AWGEupen J-Y(St)Y Lg

Yes0,8mm20,4AWGWaschek 240208

Yes0,8mm20,4AWGCoferro J-Y(St)Y

Yes0,8mm20,4AWGAnixter 4QJB2

ShieldedDiameterAWGCable type

A list of cable suppliers can be found in the back of this manual.

S Y S E M
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Cable Lengths
Validated cables:

900 metersBus Topology, max. total length

500 metersFree Topology, max. total length

320 metersFree Topology, max. node-to-node

J-Y(St)Y 2x2x0.8 cable:

1400 meters (0,65mm/24AWG)Bus Topology, max. total length

500 meters (0,65mm/24AWG)Free Topology, max. total length

400 meters (0,65mm/24AWG)Free Topology, max. node-to-node

Level IV cable:

2700 metersBus Topology, max. total length

500 metersFree Topology, max. total length

500 metersFree Topology, max. node-to-node

Belden 85102 cable:

2700 metersBus Topology, max. total length

500 metersFree Topology, max. total length

400 metersFree Topology, max. node-to-node

Belden 8471 cable:

900 metersBus Topology, max. total length

450 metersFree Topology, max. total length

250 metersFree Topology, max. node-to-node

TIA/EIA 568A Category 5 cable:

S Y S E M
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General Installation Advise

The network is polarity insensitive and therefore either of the two twisted pair wires can be
connected to either of the LON® connectors on the SYSTEM X components.

Due to the risk of cross-talk/interference, it is recommended not to run LON® Network cables
close to high voltage cable, or cables carrying video signals.

Cable Screen
In countries where the CE approval is mandatory, LON® cables with an overall screen must be
used in order to comply with EMC/EMI standard EN 50130-4.

Please see the individual SYSTEM X Installation Manuals for details on how to connect the
cable screen.

Junction Boxes
When splicing/terminating cables in the LON® Network installation, the following methods are
normally used.

Pass-Thru Junction Box
A pass-thru junction box is used to splice two cables. No SYSTEM X nodes or connectors are
provided at a pass-thru junction box.

Pass-Thru Junction Box

LON Network LON Network

Stub Junction Box
A stub junction box is used to splice two cables and provide a stub for servicing a local
SYSTEM X node.

Stub Junction Box

LON Network LON Network

To local node
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Local Loop Junction Box
A local loop junction box is used to terminate two cables, and provide a wiring loop for
servicing one, or more, local SYSTEM X nodes.

Loop Junction Box

LON Network LON Network

Local loop
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Hardware installation

One of the following LON adapters are needed to connect your computer to the LON Network.

These adapters are manufactured by the Echelon Corporation and can be purchased from
Ernitec, Echelon Offices, and Echelon world wide distributors. A list of distributors can be
found in the back of this manual. Updated information is also available on www.echelon.com

These two adapters are verified by Ernitec A/S, to be 100% compatible with the NodeManager
software. However, other adapters are available on the market (e.g. EasyLon USB Interface from
Gesytec: www.gesytec.de), and will most likely work without problems.

SLTA-10 Model 73351 (Ernitec model NM-SLTA)
This is an external RS232-to-LON adapter, which is connected to a COM port on your  
computer. The SLTA-10 makes a direct connection from PC to LON and requires no software
drivers to be installed.

Due to its flexibility and ease of installation, Ernitec highly recommends to use the SLTA-10
adapter.

SLTA-10 NETWORK ADAPTER

SERVICE CONFIGURATION
NETWORK

POWER EIA-232

The SLTA-10 needs an external power supply of 9-30VAC or DC (included).

The configuration switch should be set as follows, to be compatible with the NodeManager.

CONFIGURATION

The LON cable is connected to the NETWORK connector.

The EIA-232 9 pin D-Sub connector, connects to the computer COM Port 
(Pin2-to-2, Pin3-to-3 and Pin5-to-5)

PCC-10 Model 73200 (Ernitec model NM-PCMCIA)
This is a Type II PC Card (formerly PCMCIA) used to connect  your Laptop computer to LON.

The PCC-10 card can be used with a Laptop computer having a Type II PC Card Slot.

The PCC-10 adapter requires a driver to be installed on your PC.  The latest version of the
driver should be downloaded from www.echelon.com and installed BEFORE installing the
PCC-10 card. Once the driver is installed, insert the PCC-10 card, restart the computer and the
installation should proceed automatically.

If in doubt, or in case of problems (conflicts with other programs, IRQ's, etc.) please leave the
installation to an experienced computer user.
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NodeManager Installation

Internet Explorer

If not already installed on your computer, you must start by installing Internet Explorer version
5.5 (included on the NodeManager CD-ROM).

Insert the CD-ROM in your CD drive. If auto run is enabled, it can be bypassed by holding
down the left [SHIFT] key on the PC keyboard, while loading the CD-ROM.

Select Start -> Run, and type D:\msie55\ie5setup.exe (D, being your CD-ROM drive). Follow the
on-screen instructions to install Internet Explorer.

Acrobat Reader

Acrobat Reader is used to read the SYSTEM X manuals included on the CD-ROM.

If not already installed, run the file d:\ar500enu.exe to install it.

NodeManager

Insert the CD-ROM in your CD drive. If auto run is enabled, the installation program will start
automatically.

Alternatively, select Start -> Run, and type D:\setup (D, being your CD-ROM drive).

The Install Shield Wizard will start, and guide you through the installation of NodeManager.

The following menu will appear:

Click Next.
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Carefully read the license agreement, and click Yes if the terms are accepted.

Select the type of installation required and click Next.
The Custom installation should only be used by experienced Node Manager users.
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Setup is copying the NodeManager files to your computer. 

.

Carefully read the content of the IMPORTANT text box.

Close the text box, and Click Finish to complete the NodeManager installation.

When doing a first time NodeManager installation, you will be prompted to restart the
computer to complete the installation.
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Installing SYSTEM X on LON

A SYSTEM X installation is made in the following steps:

v LON cable installation.
v Installation of SYSTEM X equipment (referred to as Nodes).
v Configuration with the NodeManager software.

When all Nodes are installed on the LON Network, and the Computer with the NodeManager
software is connected to the LON Network, it is IMPORTANT to configure the SYSTEM X
nodes in the following order:

v Start NodeManager, open your database, and connect to the LON Network
v Select menu Properties -> Network enable add Node on service pin - click OK.
v Press the Service Pin on all connected SYSTEM X nodes, taking careful note of the

order in which the pin's are pressed.
v The SYSTEM X nodes are registered by NodeManager in the same order that the

Service Pin's are pressed, and presented with their unique Neuron ID and numbered
from 1 and up. Please note that this is the only way to identify the nodes.

v Rename all nodes to something logical for the specific installation.

See the following chapters for details.

It is of out most importance to keep note of the order in which the Service Pin's are pressed on
the SYSTEM X nodes. Since the NodeManager will register the nodes in the same order,  this
will be the only way to identify the different SYSTEM X nodes in the NodeManager software.

A template, which can be used to keep track of the order, is enclosed in the back of this
manual. Please use it to make additional copies.

Example:

Alarms 1-8, control room.Alarm Box 19

Stairs, east wing.PTZ Camera 88

Main entrance.PTZ Camera 77

South entrance.PTZ Camera 46

Guard room.Keyboard 35

Control room.Keyboard 24

Main reception.Keyboard 13

Slave matrix, camera 33-64, monitor 1-16.Matrix2

Master matrix, camera 1-32, monitor 1-16.Matrix1

DescriptionNode TypeNode No.
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The following chapters in this manual, are sorted in the order that NodeManager
would normally be used, when doing a first time installation.

NodeManager

To start NodeManager, click the NodeManager icon created on your desktop. NodeManager is
also installed in the Ernitec Program Folder: Start -> Programs -> Ernitec.

You will be prompted if you want to add Nodes in this session. If you want to add new System
X units, or if it is a first time installation, you should answer Yes.

User interface
When first started, the NodeManager will look as follows:

When started, NodeManager will open the most resent database created (if any).

To start a new Database, select File -> New and key in a name and file location for your
Database.
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Click Save.

This is the basic interface when a new database has been made.
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Online/Offline

Click the green online symbol to connect NodeManager to the
LON Network. Click the red symbol to go offline.

Select which adapter is used to connect to the LON Network.

PCC-10

The PCC-10 adapter is a Type II
PC Card, normally used with
laptop computers.

The device number is defined
during installation of the
adapter.

SLTA-10

The SLTA-10 adapter is an
external RS232-to-LON adapter,
normally used to connect a PC
COM port to the LON Network.

Select which COM port is used
on the PC. Switch settings
required to work with
NodeManager, is shown in this

menu.

The LON adapter is only selected when going online for the first time.

If, at a later stage, it is required to change the LON adapter, use the menu Database -> Go
Online Dlg.

Add Node on Service pin
Check this for Node Manager to add Nodes to the database when service pins are pressed.
When Node Manager is online, the menu Properties -> Network can also enable service pins.

Service Pins
After going online (when doing a first time installation), it is time to press the Service Pins on
all connected SYSTEM X nodes.

For the location of the Service Pins, please see the Installation Manuals for the specific
equipment.
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As mentioned in chapter: Installing SYSTEM X on LON, it is very important to keep note of the
order in which the Service Pins are pressed.
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Nodes
Nodes are the different SYSTEM X units connected on the LON Network. After pressing the
Service Pin's on the SYSTEM X units, they will be listed together with their Neuron ID.

Neuron ID's Node number

Data Base activity         LON Network activity
Neuron ID

Each SYSTEM X unit is identified by the NodeManager with a unique Neuron ID. The Neuron
ID is detected by NodeManager when the Service Pin is pressed on the SYSTEM X units.

Since it is impossible to determine from the Neuron ID which type of SYSTEM X unit it is, all
Neuron ID's will be numbered from 1 and up, in the same order which the Service Pin's are
pressed.

It is therefore very important to keep note of the order in which the Service Pin's are pressed,
and when NodeManager has identified all nodes, rename them to something recognizable
(e.g. Keyboard 1, PTZ Camera 1, etc.).

Data Base activity

Shows if the NodeManager Data Base is busy. After having pressed the service pins, the Data
Base activity should read 'DB Ready' (Data Base Ready) before proceeding with the installation.

LON Network Activity

For information only. Shows the transmission activity on the LON Network.
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Renaming Nodes

Nodes are renamed by clicking the node, and selecting Nodes -> Properties, or by
double-clicking the Node.

Key in a new name for the node, preferably a name that makes it easy to identify the SYSTEM
X unit in the specific installation.

Deleting Nodes

To delete a node, click the node and select  Nodes -> Delete.
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Autobind Plugin
Once all nodes have been registered by the NodeManager, they all have to be configured to
be able to communicate with each other.

The Autobind plugin is used by the NodeManager to determine which nodes are connected
on the LON Network, and to tell the individual nodes which other nodes are present.

NodeManager does not need to be online with the LON Network, to run the Autobind Plugin.
When going online, the actual binding of the units, will be executed automatically.

Start the Autobind Plugin by opening System Plugins, and double-clicking on Automatic
Binder Ernitec System X.

Click on the icon/text next to each option, and define the following:

v Camera/monitor range, for each Matrix X and I151SX-Remote.
v Unique ID numbers for each Keyboard X.
v Unique ID numbers for each PTZ camera (equal to the camera input on the matrix).
v Camera range for Converters, I142SX-ERNA and I151SX-DOME.
v Number of DVR's connected to the I151SX-DVR.
v Unique ID numbers for each Alarm unit, I121DX, I141DX and I151SX-ALARM.
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Once all ID's and camera/monitor ranges are defined, click on Bind devices.

Autobind will now bind all devices on the LON Network, which might take several minutes
depending on the number of nodes on the network.

Do NOT use any other features of NodeManager, while Autobind is running.

The progress can be followed at the bottom status bar. When status reads DB Ready, autobind
is completed.

If any errors are displayed, the units giving the error will be listed in the binding progress
window. Most errors are caused by wrong Neuron software in the unit, see chapter Upgrading.

Error symbols

If AutoBind detects any conflicts, it will display an error symbol next to the option causing the
conflict.

Unknown state.?
Conflict, duplicate ID or overlap.�q
No conflicts. √√
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Configuration Plugin
With the Configuration Plugin, all parameters for the complete SYSTEM X can be defined and
downloaded to the SYSTEM X units.

NodeManager does not need to be online with the LON Network, in order to use the
Configuration Plugin.

Start the Configuration Plugin by opening System Plugins, and double-clicking on
Configuration Ernitec System X.

Saving Setup - IMPORTANT

Settings made in the Configuration plugin are saved automatically to the database, when the
Configuration PlugIn is closed.

Download settings

After having made all settings, click on Download, to download settings to the SYSTEM X
units.

Depending on the number of SYSTEM X units, this may take several minutes.

Export Settings

Exports the System X Configuration to a file <DATABASENAME>.sysx.txt. Use this to make a
backup, which can be imported in a later Nodemanager version.

Import Settings

Import settings file <DATABASENAME>.sysx.txt, exported by an earlier NodeManager version.

.
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Languages
Click on Languages, and select which language(s) should be selectable from the keyboard(s).

Click the [...] button to select the language.

The language files contains the operator messages displayed in the SYSTEM X keyboard. Five
languages are included as standard: English, German, French, Swedish and Danish.

In the User setup menu, it is defined which language is default for the specific user.
From the SYSTEM X keyboard, it is also possible to select between the different languages.
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Edit language
Clicking Edit will bring up a text editor where the selected language can be edited/translated.
When editing a language file, please remember to save the file with a new file name, so that
the original language file is kept.

Only the text in " " can be edited, e.g. for the line: txt_2="Press CONTROL." only the text
Press CONTROL should be edited.

If the text consists of two lines (e.g. txt_20="Camera" and txt_21="does not respond."),
the SYSTEM X keyboard inserts a fixed number/text between the two lines, e.g. in Camera 12
does not respond the '12' is inserted by the keyboard.

An edited/translated text can be maximum 40 characters long, including space(s) and the fixed
number/text inserted by the keyboard X (if any). Only the English character set, and numbers
0-9, are supported.

When all texts are edited/translated, save the file with a new file name, and select it clicking
the [...] button.
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Users

Clicking on the Users icon, will bring up the User Setup menu where up to 50 users can be
added, each with their own individual password and parameters.

User Id
This is a fixed user ID.

Name
Key in the name of the user. Up to 20 characters are available.

Password
Assign a unique 4-digit password to each user.

Valid keys
The user can be limited to be able to operate only limited parts of the SYSTEM X.

Key group 0 (G0 All):
Full access to all functions of SYSTEM X.

Key group 1 (G1 -PTZ):
PTZ camera operation disabled.

Key group 2 (G2 -Setup):
System Setup disabled.

Key group 3 (G3 Alarm):
PTZ operation, system setup and camera selection disabled.

Key group 4 (G4 -Alarm):
All alarm functions disabled.

Key group 5 (G5 Setup):
Alarm functions and PTZ operation disabled.

Key group 6 (PTZ):
Alarm functions and system setup disabled.

Key group 7 (Camera):
Alarm functions, PTZ operation and system setup disabled.
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Priority
Define a keyboard priority between 1-50, 1 being highest priority.

Language
Select the default language for the user.

LogOff
The keyboard will automatically log off after the specified time of inactivity. Setting the time to
0 (zero) will disable the automatic log off.

Sound
Enable or disable key press and warning sounds.

Profile
Select the user profile (if any) for this specific user.
Default is Profile 1, which will allow the user to select all cameras, on all sites.

User Profiles

In the user setup menu, click the Profiles button, to define user profiles.

User profiles are used to limit user access to specific Sites and cameras, during different
periods.

Up to 8 different profiles can be created. Each profile can be used by several users.

Click Add to create a new Profile.

Camera
In the drop-down menu, select a specific matrix, or select All.

Select which cameras user with this specific profile, should be allowed to select.
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Access
User acces can be limited to specific periods/days of the week. The time can be set in steps of
30 minutes.

Select the site to edit, and click the Access/Denied button.

To set the same access for all sites, click the All button.

Activity times
Use the right/left mouse keys to enable (green) or disable (red) the time intervals.

The blank buttons to the right of each day, is used to enable/disable an entire day.

Green: Access.

Red: No access.
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Sites

In an installation with Several Sites, the sites can be renamed to something more logical for the
specific installation.

Double-click on the Name, and type in the new name.

The site names are only used in the NodeManager menus, it is not downloaded to any SYSTEM
X units.
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Keyboards

Clicking on Keyboard, will bring up the Keyboard Setup menu where the Keyboard parameters
can be programmed.

Users
Select which users should have access to this keyboard.

Remaining Users/Profiles
For information only. Tells how many users and profiles are left.

Default
Select if a user should be “Default”, meaning that he will be able to log on without the use of
ID and password.

Log on macro
Select a macro that is automatically executed when the user logs on.

Monitors
Select which monitors it should be possible to access from this keyboard.
The monitors can be assigned any logical address (i.e. the number used to select the monitor)
between 1-999.

Profile
For information only. Shows the user profile, selected in the User Setup menu.
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Matrix

Set the video input termination on/off for the matrixes, where camera inputs are looped.

Terminations
Select which camera inputs, for the specific matrix, that should be terminated with 75 ohm.

Clock
Select which matrix should broadcast the time/date to other matrixes/keyboard in the LON
Network. Normally, the Master matrix is broadcasting the time/date.
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Cameras

Define the camera parameters for the camera range covered by the specific site.

Camera input
The physical camera input on the matrix.

Camera Text
The camera ID text displayed on the monitors. 20 characters are available for text.

Logical address
The logical address, is the number the operator has to key in to select the camera input.
The logical address can be changed to anything between 1-9999. This could be useful, in
order to make a more logical camera numbering for the specific site.
Please note, that it is not allowed to assign the same logical address to more cameras.

Device
Select the type of camera/device connected to the camera input.
Selectable options are:

Cam Fixed - Normal fixed camera.
DVR - Video output from DVR.
NC - No connection.
Link - Camera input used as video link to remote site.

For info only:
Cam PTZ - PTZ camera.

Device info
When Device is set as Link, select the monitor output on the remote site, which is connected to
this camera input.

Relay Box
Specify if a relay box should be assosiated with the camera input. When selecting the camera,
control of the relay box is automatically given.

Sync loss alarm (only if M32SYNX sync loss module is fitted)
Select if an alarm should be generated if the camera synchronization pulse is lost (e.g. if the
cable is cut, or the camera fails).
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Sync loss priority
The alarm priority for the sync loss alarm. Valid range is 1-49, one being highest priority.

Sync error number
Specify how many synchronization pulses should be lost, before an alarm is generated. Default
is 2, which is equal to approx. one second. Maximum is 10.

Default values
Loads default values for all sync loss alarms.
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Monitors

Define the monitor parameters for the monitor range covered by the specific site.

Monitor output
The physical monitor output on the matrix.

Alarm Keyboard
Define which keyboard should take control of the monitor in an alarm situation. If the first
keyboard defined, is already handling a higher priority alarm, more keyboards can be defined
to handle the alarm(s).

Alarm Dwell Time
Dwell time for alarm cameras running in a sequence on the monitor.

Default Camera
Define which camera should be displayed on the monitor after power up of the matrix.

Status Text offset
The Status text, displayed in the top of the picture, can be moved 16 pixels up or 14 pixels
down.

Camera Text offset
The Camera ID text, displayed in the bottom of the picture, can be moved 16 pixels up or 14
pixels down.

Double Text Height
Tick this box if the texts, displayed on the monitor, should be displayed in double height.

Camera Text On
Select if the Camera ID text should be displayed as default. The operator can also toggle the
text on/off from the SYSTEM X Keyboard.

Status Text On
Select if the Status text should be displayed as default. The operator can also toggle the text
on/off from the SYSTEM X Keyboard.
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Time/Date Text On
Select if the Time/Date should be displayed as default. The operator can also toggle the
Time/Date on/off from the SYSTEM X Keyboard.

ALL (for text settings)
Use the top ALL option, if all text settings should be the same
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Alarms

Clicking on Alarms, will bring up the Alarm Setup menu where the SYSTEM X alarm handling
is defined. Up to 1024 alarms per site can be programmed.

Click on Add, to add a new alarm to the SYSTEM X.

Num. (number)
Global alarm number used as reference when programming alarms in Ernitec LON Alarm Box
(I141DX), Telemetry Receiver (R131VX) and Converter (I142SX) plugins.

Addr. (address)
This field shows the alarm address (unit number and input). Click it to change the alarm
address/type settings.
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Alarm address
Select where the alarm originates from. Options are:

Alarm devices
The alarm is connected to an I141DX LON Alarm Box, or I121DX Alarm Rack.

Cameras
The alarm is a Tamper Alarm from a R131VX Telemetry Receiver or I142SX 
converter.

Matrix
The alarm is a Sync Loss alarm from a SYSTEM X matrix.

The alarm is selected by clicking on the specific equipment and selecting the alarm input, or
type.

Several alarms can be added by clicking on the text 0 Alarm, and clicking on the OK button.

Monitor Text
Type in the alarm identification text displayed on the alarm monitor. Maximum 15 characters
are available.

Camera
The alarm camera to be displayed.

Mon Priority (Monitor Priority)
Select the monitor(s) that should display the alarm camera(s).

If only one monitor is selected (Priority 1 monitor), the alarm camera will either be displayed,
put in a queue, or sequenced on this monitor, depending on the parameters programmed in
the advanced alarm setup.

If more alarm monitors are defined (Priority 2, 3 or 4), the alarm camera will be displayed on
the first free monitor, if a higher priority alarm already is displayed on the Priority 1 monitor.

Source
Opens the plugin associated with the Alarm. Program the Alarm Setup part of the plugin, to
match the required action for the alarm. Please see the separate chapter on the plugin for more
information.

.
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Advanced Alarm Handling
Clicking the Advanced button, will open the advanced part of the alarm handling.

Zones
Clicking on the Zones button, will bring up the Alarm Zones menu. Up to 8 different zones can
be defined.

Select a zone to modify, or click Add to add a new zone.

Name
Key in a name to identify the zone.

Clearing time
If timed clearing mode is selected in the Advanced Alarm Setup, alarms associated with this
zone, will be cleared automatically after the specified clearing time. Maximum time is 65535
seconds (18 hours 12 min. and 15 sec.)
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Activity scheme
A week timer is available for each zone. Alarm detection can be enabled/disabled in 30
minutes intervals.

Use the right/left mouse keys to enable (green) or disable (red) the alarm zone intervals.

The blank buttons to the right of each day, is used to enable/disable an entire day.

Green: Alarms are active (enabled).

Red: Alarms are inactive (disabled).

Day to use as holiday
Set which day - in Alarm Zone 1 - should be used as holiday. Holidays  are defined in the
K111DX keyboard, please see the K111DX Installation Manual for details.

Time/Date
Select if time and/or date should be displayed on the alarm monitor.

Monitor after alarm
Select the monitor state after all alarms are cleared.

Default camera: The default camera defined in Monitor setup.
Previous camera: The camera displayed prior to the alarm(s).
No change: The alarm camera will stay on the monitor.
Blank: The monitor will blank (no camera).

Clearing mode
Select how the alarm(s) should be cleared.

Off with alarm: The alarm(s) are automatically cleared, when the alarm contact 
resets.
By keyboard: The operator has to press the Alarm key on the keyboard.

Clear active alarm: Select if it should be possible for the operator 
to clear alarms that are still active.
Timed from zone: Alarm(s) clears automatically after the time set in the alarm
 zone.

Queue Action
Define what should happen if the priority monitors are controlled by other (higher priority)
alarms.

Discard if no monitor: If there are no lower priority monitors free, or defined, 
the alarm will be scrapped.
Set on monitor queue: If there are no lower priority monitors free, or defined, 
the alarm will be set on queue on the monitor selected in the drop-down menu.
Allow seq. on monitor: If a high priority alarm is controlling the alarm monitor, 
and a lower priority alarm is activated, the lower priority alarm will be sequenced 
with the high priority alarm, if Allow sequencing on monitor is selected for the 
high priority alarm.

Secondary alarm handling
In order to e.g. have more cameras displayed on more monitors, PTZ cameras going to presets,
AUX relays activated, etc., an alarm can start a macro (defined in the Macro setup).

Please note, that the macro should not include monitors and/or PTZ control which are already
used by alarms.
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Monitor after macro
Select the monitor state after the macro has been terminated.

Default camera: The default camera defined in Monitor setup.
Previous camera: The camera(s) displayed prior to the macro.
No change: The camera(s) selected by the macro will stay on the monitor.
Blank: The monitor will blank (no camera).

Relays
Select an Alarm Box and relay, that should be activated by the alarm.

Please note that the relay is not deactivated when the alarm is cleared. The relay has to be
deactivated by the operator, or timed via the relay box PlugIn.
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Macros

Clicking on Macros, will bring up the Macro Setup menu where the SYSTEM X macros can be
programmed. Up to 64 macros can be programmed. Macros are started from the SYSTEM X
keyboard, or by alarms.

Macros are used to perform automated sequences of operations.

Do not include alarm monitors in the macros.

Click on a macro to modify an existing macro, or click on Add to add a new macro.
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Macro Commands
The following commands can be used when programming macros.

Mx: Selects monitor 'x'.
Mx+: Selects monitor 'x' and takes control of the monitor (used if PTZ control is needed).
Mx-: Releases control of monitor 'x'.

Cx: Selects camera 'x' on the previously selected monitor.
Cx+: Selects camera 'x' and takes PTZ control.
Cx-: Releases PTZ control of camera 'x'.

Px: Calls preset 'x' on the selected PTZ camera.

Rx+: Activates AUX relay 'x' on the selected PTZ camera.
Rx-: Deactivates AUX relay 'x' on the selected PTZ camera.

Sx: Start camera sequence 'x' on the selected monitor.

Bx+: Takes control of LON Box 'x'.
Bx-: Releases control of LON Box 'x'.

Ax+: Activates AUX relay 'x' in the selected LON Box.
Ax-: Deactivates AUX relay 'x' in the selected LON Box.

Dx: Makes a 'x' seconds delay in the macro.

 , : Comma, used to separate commands in the macro.
 ; : Semicolon, ends a macro line.
Jx: Jumps to macro line number 'x', and repeats the macro in a loop.
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Sequences

Clicking on Sequences, will bring up the Sequence Setup menu where the SYSTEM X camera
sequences can be programmed. Up to 64 sequences can be programmed.

Click on a sequence to modify an existing sequence, or click on Add to add a new sequence.

Sequence Commands
The following commands can be used when programming sequences.

Cx: Selects camera 'x'.

Dx: Makes a 'x' seconds delay.

, : Comma, used to separate commands in the sequence.
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Upgrade Ernitec System X (System Plugin)
An existing version 1.x SYSTEM X installation, needs to be upgraded to version 2.x, in order to  
use the Remote System feature, and benefit from other new features in version 2.x.

Upgrading the system, can only be done in online mode.

Software Updates
If new software versions are issued by Ernitec A/S, they can be downloaded to the SYSTEM X
nodes via the NodeManager Upgrade Ernitec System X plugin.

There are two types of software: Neuron software and Host software.

If new software is issued by Ernitec, it might be new Neuron software, new Host software, or
both, depending on the type of new features added or bugs corrected.

Neuron Software
Neuron software is the software that provides the basic functionality for the SYSTEM X units,
e.g. handling the network communication. The settings generated by the Neuron software can
not be read or changed by the installer/user.

Neuron software consists of two files: *.xif and *.nxe. These files are placed in the folder:  
C:\Program files\ernitec\NodeManager\Software\ 

Loading Neuron Software
If not already loaded, load the new Neuron software in to NodeManager, select Configuration
-> Add -> Template.

To load the *.xif file, click the button to the right of the Template image line.

The corresponding *.nxe file (Program image) is loaded automatically, when the Template
image file is selected. 
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Host Software
Host software is the application software that provides the user interface, i.e. this is the
software that controls all user functions. The settings generated by the Host software can be
read and changed by the installer/user.

Host software are files with extension *.abs or *.mot. These files are placed in the folder: 
C:\Program files\Ernitec\Host SW\ 

Downloading software

Double-clicking on Upgrade Ernitec System X, will open the menu from where Neuron and
Host software can be downloaded.

The top table lists the System X units which has Neuron software.

Cur. File Version is the version of the software on the computer.

Cur. Node Version is the version of the software in the node.

Click on the text Version (4th column) to read the versions from the SYSTEM X units.
NodeManager will read the versions and compare them with the versions on the computer.
Units with different version will be marked for download.

Verify that the correct units are marked for download, and click the Download NXE's button,
to start the download.

IMPORTANT: After downloading Neuron software, always run AutoBind (see page 20).

Units with PlugIn: After downloading Neuron software, and running AutoBind, open the
PlugIns for the specific units and download settings again.
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Please note: Pentium II Class computers are too slow for several NXE downloads at the same
time. NodeManager will detect the Pentium Class, and display a warning to update only one
unit at a time.

The bottom table list all units which has Host software.

File path tells where to find the Host software to download, click on the button and navigate
to c:\program files\ernitec\Host SW\ and select the appropriate file. Selecting a wrong file will
not harm the unit - but it will of course not work.

Cur. Host Version is the version of the software in the node.

Click on the text Version (3rd column) to read the versions from the SYSTEM X units.

Mark the units that needs to be updated with new Host software, and click the Download
Hosts button.

In case of downloading to many similar units, click the text Path (4th column) to open a menu
where it is possible to select Host software for more units.

Click OK when done.
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Device Plugins

Dome/PTZ Interface (I151SX-DOME PlugIn)

Each I151SX-DOME interface box connected on the LON Network has its own Plugin, where  
parameters can be programmed and downloaded.

In the Node tree, select the interface box, and double-click on the
I151SX-Dome plug-in icon, to open the Plugin.

Take Control
Click the Take Control button to take Control of the camera selected in the drop-down menu
above.

Download
Click the Download button to update the I151SX-DOME with the changes made.

Upload
Click the Upload button to read the settings stored in the I151SX-DOME.
Please note that Preset Tours and Home Function, are not stored in the I151SX - but in the
actual Receiver - and can therefore not be uploaded.

About
Click the About button to display the version number of the Plugin.

S Y S E M

2853-00025 Page 47



Receiver Addresses

Up to 32 Domes/Telemetry Receivers can be controlled via the I151SX Interface.

System X Camera
The camera numbers are equal to the camera inputs defined in the AutoBind Plugin, and used
on the SYSTEM X matrix.
Double click on the camera number to open the address setup menu.

Receiver Address
The addresses set in the Domes/Telemetry Receivers.

Default
Sets the default Receiver addresses for the listed SYSTEM X cameras.

Reset
Resets all addresses to 255, and makes all addresses inactive.
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Preset

The number of presets that can be stored, depends on the actual Dome/Receiver used.

To set presets, click the PTZ button to open the PTZ control menu. Move the camera to the
required position, key in the number for the preset and click the Save button.

To call a preset, key in the preset number and click the Call button.

Please note that presets can only be saved/called, when the specific camera has been selected
in the drop-down menu, the Take Control button has been clicked and the red LED has
changed to green.
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Tours

Depending on the type of Telemetry Receiver(s) used, preset tours can be programmed and
downloaded.

Click the Tours button to program a preset tour for the selected camera..

Double-click on an entry number to edit on existing entry, or add a new.

Insert
Select an entry number, and click the Insert button, to insert a new entry. The selected entry
number will be moved down one line (Right double-clicking the entry number, will have the
same effect).

Delete
Select an entry number, and click the Delete button, to delete the selected entry.

Edit
Select an entry number, and click the Edit button, to edit the selected entry (left
double-clicking the entry number, will have the same effect).

Reset All
Clicking the Reset All button, resets all entries to [---] (no entry).

Start tour
After having downloaded a preset tour, it can be tested by clicking the Start tour button.

Dwell time
The time (in seconds) the camera stays on a preset, before continuing the tour.

Set
Click the Set button, to download the Dwell time to the selected camera.

After having programmed a preset tour, please remember to download it to the selected
camera, by clicking the Download button.
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Auto Pan

From this menu one Auto Pan tour can be programmed for the selected camera, if supported.

Remember to select the camera from the drop-down menu, and click the Take Control button,
before setting the Auto Pan limits.

Limits
Click the PTZ button to open the PTZ control window. Move the camera to the left hand limit
and click the Left Limit button. Move the camera to the right hand limit and click the Right
Limit button.

Speed (if supported)
Set the speed (in % of maximum) at which the pan should travel between auto pan limits.

Start
By clicking the Start button, the auto pan tour can be tested.
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Home Function

A Home Function can be programmed for the selected camera, if supported.

Preset
Key in the preset number that should be called, together with the inactivity time in seconds.

Preset Tour
Key in the preset tour number that should be started, together with the inactivity time in
seconds.

Auto Pan
Start the programmed Auto Pan tour, after the specified inactivity time in seconds.

Disable
Disables the Home Function feature.

Please Note: The timeout specified is automatically multiplied with 10, e.g. if 6 is specified, it
is actually 60 seconds, as in the example above.
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AUX Relays

In this menu, the operation of the AUX relays can be defined.

NO/NC
Define the inactive state of the relay: Normally Open (NO), or Normally Closed (NC).

Latch
Define if the relay should be latched (one press to activate, and another press to deactivate), or
unlatched (follows the state of the AUX key).

Timeout
Define a timeout period for the relay, if programmed as latched. The time can be defined in
hours (H), minutes (M) and seconds (S).
Setting the timeout to 0 (zero) disables the timeout.
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Alarm Setup

Define if alarms should call presets, on the connected cameras with preset features.
Alarm handling is programmed in the NodeManager S111SX.

Enable
Double click the Yes/No text, to open the alarm setup menu.
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Alarm Source

System reference
Reference to the global alarm number used in the alarm setup, defined in the Setup PlugIn.

Device type (info only)
Shows the LON unit that the alarm originates from.

Alarm type (info only)
The type of alarm.

Box (info only)
Shows the LON Control ID for the alarm device.

Input (info only)
Shows the alarm input used on the alarm device.

Alarm Handling

Preset
Define the preset to call when the alarm is activated.

AUX Relay
Define if an AUX relay should be activated on alarm.

Enable/Disable
Enable or disable if the I151SX Interface should react on the alarm, and call a preset on the
selected camera.
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Menu

Gives access to the Dome/Receiver menu system, if supported.

For details on programming the specific Dome/Receiver, please refer to the I151SX-DOME
manual, and/or the documentation for the Dome/Receiver.

Menu
When the menu is selected, the selected Receiver/Dome, will enter programming mode.

Select
Used as an Enter/Set/Select key in the programming menus.

Special
Used if the specific Receiver/Dome requires a special command to enter sub-menus.

Reset
Reset all Receiver/Dome settings to factory default (only if supported by the Receiver/Dome).

Return
Used to go back one menu page.

Arrow Keys
Used to navigate the programming menus. In some Receiver/Dome menus, right/left arrow
keys are used to make selections.
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DVR Interface (I151SX-DVR PlugIn)

Each I151SX-DVR interface box connected on the LON Network has its own Plugin, where  
parameters can be programmed and downloaded.

In the Node tree, select the interface box, and double-click on the I151SX-DVR
PlugIn icon, to open the Plugin.

Take Control
Click the Take Control button to take Control of the DVR selected in the drop-down menu
above.

Date and Time
Set time/date in all connected DVR's.

Download
Click the Download button to update the I151SX-DVR with the changes made.

Upload
Click the Upload button to read the settings stored in the I151SX-DVR.

About
Click the About button to display the version number of the  Plugin.
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DVR Addresses

Set the addresses for the connected DVR's.

DVR Number
The DVR number defined in the AutoBind Plugin.
Double click on the DVR number to open the address setup menu.

Receiver Address
The addresses set in the DVR's. Must match the addresses programmed in the DVR's.

Default
Sets the default addresses for the listed DVR's.

Reset
Resets all addresses to 255, and makes all addresses inactive.
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DVR Operations

Basic DVR functions, for verification of correct connections and setup.

For detailed description of operations, please see the documentation for the DVR.

Monitor output
Select the monitor output on the DVR in control.

Camera input
Select a camera input on the DVR in control.

Format
Select split screen format for the main DVR monitor.

Next format
Cycles through all split screen formats.

Display mode
Select between the following operations.

Record
Recording check
Playback mode
Stop recording
Freeze

PTZ
Digital zoom and pan/tilt.
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Menu

Gives access to the DVR menu system. Not all menu functions may be supported.

For details on programming the specific DVR, please refer to the documentation for the DVR.
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Serial Alarms (I151SX-ALARM PlugIn)

Each I151SX-ALARM box connected on the LON Network has its own Plugin, where  
parameters can be programmed and downloaded.

In the Node tree, select the alarm box, and double-click on the Serial Alarm icon, to
open the Plugin.

COM Port

RS232
Select the alarm protocol used.

Options are:

v SAP (Serial Alarm Protocol)
v xSAP (extended Serial Alarm Protocol)
v IEC (IEC Alarm Protocol

For detailed information, please see the Installation Manual for I151SX-ALARM.

Baud rate/Parity/Stop bits
Select the RS232 data format that corresponds to the format used by the connected alarm
equipment
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Alarms

SAI number (info only)
A list of all available alarm inputs on the I151SX-ALARM.

Ref # (info only)
Global alarm number, refers to the alarms programmed in the Configuration Plugin -> Alarms

Monitor text (info only)
The alarm text displayed on the alarm monitor. The text is programmed in the Configuration
Plugin -> Alarms.

Priority
The priority associated with the alarm. Valid priorities are 1-49, 1 being highest priority.

Logging

For future use.
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PTZ Cameras (R111CX PlugIn)

Each R111CX Telemetry Receiver connected on the LON Network has its own Plugin, where  
parameters can be programmed and downloaded.

In the Node tree, select the PTZ Camera, and double-click on the Ernitec
R111CX PlugIn icon, to open the Plugin.

Take Control
Click the Take Control button to take Control of the R111CX Telemetry Receiver.

Download
Click the Download button to update the R111CX with the changes made.

Upload
Click the Upload button to read the settings stored in the R111CX.

About
Click the About button to display the version number of the R111CX Telemetry Receiver
Plugin.
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AUX Relays

In this menu, the operation of the AUX relays can be defined.

NO/NC
Define the inactive state of the relay: Normally Open (NO), or Normally Closed (NC).

Latch
Define if the relay should be latched (one press to activate, and another press to deactivate), or
unlatched (follows the state of the AUX key).

Timeout
Define a timeout period for the relay, if programmed as latched. The time can be defined in
hours (H), minutes (M) and seconds (S).
Setting the timeout to 0 (zero) disables the timeout.
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Preset PTZ Cameras (R131VX Plugin)

Each R131VX Telemetry Receiver connected on the LON Network has its own Plugin, where  
parameters can be programmed and downloaded.

In the Node tree, select the PTZ Camera, and double-click on the Ernitec R131VX
icon, to open the Plugin.

Take Control
Click the Take Control button to take Control of the R131VX Telemetry Receiver.

Download
Click the Download button to update the R131VX with the changes made.

Upload
Click the Upload button to read the settings stored in the R131VX.

About
Click the About button to display the version number of the R131VX Telemetry Receiver
Plugin.
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Pan/Tilt Head

Pan/Tilt Head
Select the Pan/tilt head used. Supported heads are:

Ernitec MPT-5P
Molynx Mustang PT12
Prince 165
VideMech 555P
Conway C2020

Using other types of heads, may cause malfunction, or even damage to the SYSTEM X
Telemetry Receiver.

Reverse direction (Pan/Tilt)
If, for some reason, the Pan/Tilt should operate opposite of normal, the direction of pan and tilt
can be reversed. I.e. when the joystick on the SYSTEM X keyboard is pushed towards left, the
pan will turn right, and vice versa.

Camera
For future use.

Reverse direction (Zoom/Focus)
If, for some reason, the zoom/focus should operate opposite of normal, the direction of travel
can be reversed. I.e. when the zooming wide on the SYSTEM X keyboard, the zoom lens will
zoom towards tele, and vice versa.

Lens Drive Voltage
Depending on the type of motorized zoom lens used, the Lens Drive Voltage can be set to
match the zoom lens. Options are: 6VDC, 9VDC and 12VDC.

The voltage can be set individually for manual operation and for presets, if supported by the
zoom lens used.

Calibrate
Clicking on the Calibrate button, will cause the PTZ camera to start a calibration routine to
determine if wiring is made correct, and where mechanical end-stops are set. The calibration
routine also improves accuracy on presets and privacy zones.

PLEASE NOTE: The pan/tilt will move to both pan and tilt end-stops, it is therefore very
IMPORTANT that mechanical end-stops are set correct before starting the calibration routine.
Otherwise the camera might hit the wall/pole where it is mounted resulting in damage to the
wall/pole and/or PTZ Camera.
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Soft Limits

Soft Limits can be used to set end-stops that differs from the hardware end-stops.

For safety reasons, hardware end-stops should ALWAYS be set, regardless of soft limits being  
used or not.

To set Soft Limits, click the Disable button and open the PTZ control window, by clicking the
PTZ button.
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Using the PTZ buttons, move the camera to the four required limits of travel, and click the
corresponding Soft Limit button at each limit. Once all four limits are saved, click the Enable
button.
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Presets

Up to 128 presets can be stored.

To set presets, click the PTZ button to open the PTZ control menu. Move the camera to the
required position, key in number for the preset and click the Save button.

To call a preset, key in the preset number and click the Call button.
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Tours
For each PTZ camera, up to 4 preset tours - each with 30 entries - can be programmed.

Click the Tours button to program the preset tours.

Programmed tours can be tested by selecting the tour in the drop-down panel, and clicking the
Start tour button.

Double-click on an entry number to edit an existing entry, or add a new.

Preset
The preset number to go to.

Dwell Time
The time - in seconds - the PTZ camera should stay on the preset before continuing the tour.

Speed
The speed (in % of maximum) at which the Pan/Tilt should travel to the preset.

AUX Relay
AUX relay to be activated. The AUX relay is activated when the preset is called, and not when
the preset is reached.
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Relay Timeout
Timeout period for the activated AUX relay. Setting no timeout, will keep the AUX relay
constantly activated.
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Auto Pan

From this menu one Auto Pan tour can be programmed.

It is also possible to program the Auto Pan tour directly from the SYSTEM X keyboard.

Limits
Click the PTZ button to open the PTZ control window. Move the camera to the left hand limit
and click the Left Limit button. Move the camera to the right hand limit and click the Right
Limit button.

Speed
Set the speed (in % of maximum) at which the pan should travel between the auto pan limits.
The speed can also be set directly from the SYSTEM X keyboard.

Start
The Auto Pan settings can be tested by clicking the Start button.
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Home Function

A Home Function can be called after a specified time of inactivity. Maximum inactivity
(timeout) is 6553 seconds (1hour 49min. 13sec.).

Preset
Key in the preset number between 1-128 that should be called, together with the inactivity
time in seconds.

Preset Tour
Key in the preset tour number between 1-4 that should be started, together with the inactivity
time in seconds.

Auto Pan
Start the programmed Auto Pan, after the specified inactivity time in seconds.

Disable
Disables the Home Function feature.
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Speed

Sets the fixed pan/tilt speed if the R131VX is controlled from a controller/keyboard without
variable speed option.

Pan
Set the fixed Pan speed (in % of maximum).

Tilt
Set the fixed Tilt speed (in % of maximum).
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Privacy Zones

Up to 4 Privacy Zones can be defined.

If a PTZ camera enters a Privacy Zone, it will accelerate to maximum pan speed until it has left
the Privacy Zone.

When setting the Privacy Zone limits, field of view of the zoom lens used will be taken in to
account.

Disable/Enable
Prior to defining a new privacy zone, enter the number of the zone (1-4), and select Disable.

PTZ
Click the PTZ button to open the PTZ control menu.

Field Of View (FOV) Calibration
The Field Of View (FOV) calibration, is used by the R131VX to 'learn' the zoom limits of the
lens used and can improve accuracy of the Privacy Zone.

Enter FOV
If using an Ernitec Motorized Zoom lens, click the Enter FOV button, and select between the
most common types available. Please note that the camera format (1/3" or 1/2") has to be
selected as well.
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FOV Calibration
When using a Motorized Zoom Lens not listed, the FOV calibration can be done manually.

Tick the FOV Calibration box, and note that the Zoom In/Zoom Out options becomes active.

v Select the Zoom Out option.
v Zoom fully out (wide), and move the camera to the upper left corner of the Privacy

Zone.
v Click the UL (Upper Left) button.
v Move the camera to the lower right corner of the Privacy Zone.
v Click the LR (Lower Right) button.

v Select the Zoom In option.
v Zoom fully in (tele), and move the camera to the upper left corner of the Privacy Zone.
v Click the UL (Upper Left) button.
v Move the camera to the lower right corner of the Privacy Zone.
v Click the LR (Lower Right) button.

The Field Of View (FOV) has now been set for the Privacy Zone, and will be taken in to account
when defining the Privacy Zone.

Privacy Zone
After having defined the Field Of View (FOV), or selected the Ernitec lens used, the Privacy
Zone can now be defined.

v If ticked, un-tick the FOV Calibration box.
v Zoom fully out (wide).
v Move the camera to the upper left corner of the Privacy Zone.
v Click the UL (Upper Left) button.
v Move the camera to the lower right corner of the Privacy Zone.
v Click the LR (Lower Right) button.
v Select Enable.

Please note
It is advisable to make the Privacy Zone about 50% larger than the actual privacy area, to
ensure that privacy is achieved under all operating conditions.
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AUX Relays

In this menu, the operation of the AUX relays can be defined.

NO/NC
Define the inactive state of the relay: Normally Open (NO), or Normally Closed (NC).

Latch
Define if the relay should be latched (one press to activate, and another press to deactivate), or
unlatched (follows the state of the AUX key).

Timeout
Define a timeout period for the relay, if programmed as latched. The time can be defined in
hours (H), minutes (M) and seconds (S).
Setting the timeout to 0 (zero) disables the timeout.

S Y S E M

2853-00025 Page 77



Alarm setup

Define how alarms, received via the LON Network, should be handled by the R131VX.

Enable
Double click the Yes/No text, to open the alarm setup menu.
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Alarm Source

System reference
Reference to the global alarm number used in the alarm setup, defined in the Setup PlugIn.

Device type (info only)
Shows the LON unit that the alarm originates from.

Alarm type (info only)
The type of alarm.

Box (info only)
Shows the LON Control ID for the alarm device.

Input (info only)
Shows the alarm input used on the alarm device.

Alarm Handling

Preset
Define the preset to call when the alarm is activated.

AUX Relay
Define if an AUX relay should be activated on alarm.

Enable/Disable
Enable or disable if the R131VX Telemetry Receiver should react on the alarm.
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LON Alarm Box (I141DX Plugin)

Each Alarm Box connected on the Lon Network has its own Plugin, where  parameters can be
programmed and downloaded.

Double-clicking on the Ernitec I141DX icon, will open the
I141DX Plugin.

Take Control
Click the Take Control button to take Control of the I141DX Alarm Box.

Download
Click the Download button to update the I141DX with the changes made.

Upload
Click the Upload button to read the settings stored in the I141DX.

About
Click the About button to display the version number of the I141DX Plugin.

Site (info only)

Shows the site, assigned by the autobind plugin

ID (info only)

Shows the control ID, assigned by the autobind plugin.

S Y S E M

Page 80 2853-00025



AUX Relays

Define how the 8 AUX relays should operate.

NO/NC
Select the inactive state of the relay NO (Normally Open) or NC (Normally Closed).

Latch
Select if the relay should be latched or unlatched.

Timeout
If the relay is set to Latch, a hold time for the relay can be defined. Setting the timeout to 0
(zero) will hold the relay until the operator deactivates it.
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Alarm configuration

Define priority and state of the alarm inputs.

Alarm Ref (info only)
Displays the reference to the global alarm number used in the alarm setup, defined in the
Setup PlugIn.

Open/Close
Define if the alarm will activate when an alarm contact is closed (Close) or when an alarm
contact is opened (Open).

Priority
Set the priority of the alarm input. Valid range is 1-49, one being highest priority.
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I142SX LON-to-ERNA Converter Box (I142SX-ERNA PlugIn)

Each I142SX-ERNA connected on the Lon Network has its own Plugin, where  parameters can
be programmed and downloaded.

The I142SX Converter Box is used to convert from LON to the  ERNA PTZ protocol,
enabling SYSTEM X to control SYSTEM 1000M Telemetry Receivers.
Double-clicking on the Ernitec ERNA icon, will open the I142SX-ERNA Plugin.

Take Control
Click the Take Control button to take Control of the camera selected in the drop-down menu
above.

Download
Click the Download button to update the I142SX with the changes made.

Upload
Click the Upload button to read the settings stored in the I142SX.
Please note that Preset Tours and Home Function, are not stored in the I142SX - but in the
actual Receiver - and can therefore not be uploaded.

About
Click the About button to display the version number of the ErnaCnv Plugin.
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Receiver Addresses

Up to 32 ERNA protocol Telemetry Receivers can be controlled via the I142SX converter.

Supported Telemetry Receivers are: BDR-51X, BDR-55X, BDR-575 and Saturn Dome.

System X Camera
The camera numbers are equal to the camera inputs defined in the AutoBind Plugin, and used
on the SYSTEM X matrix.
Double click on the camera number to open the address setup menu.

Receiver Address
The addresses set in the ERNA Telemetry Receivers.

Default
Sets the default Receiver addresses for the listed SYSTEM X cameras.

Reset
Resets all addresses to 255, and makes all addresses inactive.
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Preset

The number of presets that can be stored, depends on the actual Telemetry Receiver used.

To set presets, click the PTZ button to open the PTZ control menu. Move the camera to the
required position, key in the number for the preset and click the Save button.

To call a preset, key in the preset number and click the Call button.

Please note that presets can only be saved/called, when the specific camera has been selected
in the drop-down menu, the Take Control button has been clicked and the red LED has
changed to green.
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Tours

Depending on the type of Telemetry Receiver(s) used, preset tours can be programmed and
downloaded.

Click the Tours button to program a preset tour for the selected camera..

Double-click on an entry number to edit on existing entry, or add a new.

Insert
Select an entry number, and click the Insert button, to insert a new entry. The selected entry
number will be moved down one line (Right double-clicking the entry number, will have the
same effect).

Delete
Select an entry number, and click the Delete button, to delete the selected entry.

Edit
Select an entry number, and click the Edit button, to edit the selected entry (left
double-clicking the entry number, will have the same effect).

Reset All
Clicking the Reset All button, resets all entries to [---] (no entry).

Start tour
After having downloaded a preset tour, it can be tested by clicking the Start tour button.

Dwell time
The time (in seconds) the camera stays on a preset, before continuing the tour.

Set
Click the Set button, to download the Dwell time to the selected camera.

After having programmed a preset tour, please remember to download it to the selected
camera, by clicking the Download button.
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Auto Pan

From this menu one Auto Pan tour can be programmed for the selected camera, if supported.

Remember to select the camera from the drop-down menu, and click the Take Control button,
before setting the Auto Pan limits.

Limits
Click the PTZ button to open the PTZ control window. Move the camera to the left hand limit
and click the Left Limit button. Move the camera to the right hand limit and click the Right
Limit button.

Speed (if supported)
Set the speed (in % of maximum) at which the pan should travel between auto pan limits.

Start
By clicking the Start button, the auto pan tour can be tested.
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Home Function

A Home Function can be programmed for the selected camera, if supported.

Preset
Key in the preset number between 1-128 that should be called, together with the inactivity
time in seconds.

Preset Tour
Key in the preset tour number that should be started, together with the inactivity time in
seconds.

Auto Pan
Start the programmed Auto Pan tour, after the specified inactivity time in seconds.

Disable
Disables the Home Function feature.

Please Note: The timeout specified is automatically multiplied with 10, e.g. if 6 is specified, it
is actually 60 seconds, as in the example above.
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Alarm Setup

Define if alarms should call presets, on the connected cameras with preset features.
Alarm handling is programmed in the NodeManager S111SX.

Enable
Double click the Yes/No text, to open the alarm setup menu.

S Y S E M

2853-00025 Page 89



S Y S E M

Page 90 2853-00025



Alarm Source

System reference
Reference to the global alarm number used in the alarm setup, defined in the Setup PlugIn.

Device type (info only)
Shows the LON unit that the alarm originates from.

Alarm type (info only)
The type of alarm.

Box (info only)
Shows the LON Control ID for the alarm device.

Input (info only)
Shows the alarm input used on the alarm device.

Alarm Handling

Preset
Define the preset to call when the alarm is activated.

AUX Relay
Define if an AUX relay should be activated on alarm.

Enable/Disable
Enable or disable if the I142SX converter should react on the alarm, and call a preset on the
selected camera.
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I121DX Alarm Rack (I121DX PlugIn)

Each I121DX Alarm Rack connected on the Lon Network has its own Plugin, where  
parameters can be programmed and downloaded.

Double-clicking on the Ernitec I121DX icon, will open the I121DX
Plugin.

Take Control
Click the Take Control button to take Control of the I121DX Alarm Box.

Download
Click the Download button to update the I121DX with the changes made.

Upload
Click the Upload button to read the settings stored in the I121DX.

About
Click the About button to display the version number of the I121DX Plugin.
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Alarm Input Setup

Define active state and active period of the alarm inputs.

Alarm Input
Double click the alarm input number to open the Alarm Input menu.

Active State
Select if the alarm should activate when the input is Open or Closed.

Min. Active Period
Define if the alarm input should be active for a minimum period, before being recognized by
the I121DX as a valid alarm. This can be used to eliminate false alarms caused by bouncing
alarm contacts and/or noise pulses.
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Default Active State
To set all alarm inputs to the same default active state, select Open or Closed, and click the Set
ALL key.

Default Min. Active Period
To set all alarm inputs to the same default minimum active period, select the minimum time,
and click the Set ALL key.

S Y S E M

Page 94 2853-00025



Alarm Combination Setup

Define various alarm conditions that has to be fulfilled, before an alarm is generated.

Up to 32 Alarm Combinations, each with up to 8 Alarm Compositions, can be defined.

Alarm Compositions consists of a number of alarm inputs, which are combined with AND or
OR.

AND: All alarm inputs must be active, to generate an alarm.

OR: At least one alarm input must be active, to generate an alarm.

Furthermore, up to 8 Alarm Compositions can be combined in the Alarm Combination (with
AND or OR) before generating an alarm.

Help
Click on the Help button, to open a help menu with details on the Alarm Combinations.

Reset All
Clears all Alarm Combinations made.
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Alarm Combination
Double click on the Alarm combination 'x' text, to open the Alarm combination set up menu.

Alarm Composition
Click on one of the Alarm composition boxes 

From the list of available alarm inputs, select which inputs should be included in the Alarm
Composition.

AND / OR
Two options are available:

� AND: All alarm inputs in the composition must be active, to generate an alarm.
� OR: At least one alarm input in the composition must be active, to generate an alarm.
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Alarm Setup

Define how the alarms should be generated by the I121DX.

Alarm Number
The actual alarm number generated by the I121DX alarm rack. Up to 128 alarms are available
from each I121DX alarm rack. Double click on the on the alarm number to open the Alarm
Setup menu.

Alarm Ref (info only)
Displays the reference to the global alarm number used in the alarm setup, defined in the
NodeManager Setup PlugIn.

Alarm Combination
The Alarm Combination that must be valid, before the alarm is generated. If no Alarm
Combination is selected, the alarm is handled as an individual alarm.
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Priority
Set the priority of the alarm . Valid range is 1-49, one being highest priority.
Priority 0 disables the alarm.

Alarm Hold
Specify a time (in seconds) that the alarm should be held active, after the alarm input is
deactivated.
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AUX Relays

Define how the 4 AUX relays and 4 open collectors should operate.

AUX NO/NC
Select the inactive state of the relay NO (Normally Open) or NC (Normally Closed).

AUX Latch
Select if the relay should be latched or unlatched.

AUX Timeout
If the relay is set to Latch, a hold time for the relay can be defined. Setting the timeout to 0
(zero) will hold the relay until the operator deactivates it.

OC Latch
Select if the open collector output should be latched or unlatched.

OC Timeout
If the open collector is set to Latch, a hold time for the output can be defined. Setting the
timeout to 0 (zero) will hold the output until the operator deactivates it.
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Password
The NodeManager Program can be password protected.

Default password is: System X (space between System and X).

To enter a new password select the menu Configurations password.

A new password can be defined by clicking New password.

A password must be minimum 5 characters long. The program distinguish between capital and
small letters. It is very important to keep a note of the password used.

To disable the password check, define the default password as a new password.
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Adding Plugins
When installing NodeManager, all PlugIns are automatically added.

However, Ernitec may release new products, or updates, which requires a new plugin to be
added to the NodeManager.

To add a new Plugin, select Configuration -> Add -> Plugin...

Click the button next to the Plugin *.dll line, and select the plugin.dll file, which is placed in
the folder: ..\Ernitec\NodeManager\Plugins\
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Select the PlugIn.dll file, and click Open.
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Adding Templates
Templates are basic software (Neuron software), used by all SYSTEM X units.

When installing NodeManager, all Neuron software's are automatically added.

However, Ernitec may release new products, or updates, which requires a new Neuron software
to be added to the NodeManager.

To add the Neuron software, select Configuration -> Add -> Template...

Click the button next to the Template image *.XIF line, and select the *.xif file, which is placed
in the folder: ..\Ernitec\NodeManager\Software\
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Open

Select the *.xif file, and click Open.

The Program image *.nxe file is loaded automatically when selecting the *.xif file

It is possible to select several files, by holding down [CTRL] and clicking the files.

IMPORTANT: After downloading Neuron software, always run AutoBind (see page 18).

Units with PlugIn: After downloading Neuron software, and running AutoBind, open the
PlugIns for the specific units and download settings again.
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Updating NodeManager
If a new NodeManager is released by Ernitec, the existing NodeManager can easily be
updated.

If updating from NodeManager version 1.7, all nodes (with Neuron ID's) can be exported to a
file, and imported once NodeManager has bee updated to version 2.1.

In version 1.7 select menu File -> Export

In version 2.1 select menu Database -> Import

This will save to work of having to press all service pins again.

It is always a good idea to Export the Neuron ID’s after installation is done, then it is “easy” to
get the Neuron ID’s in case the Database should be lost.

Insert the new NodeManager CD-ROM in your CD drive. If auto run is enabled, the installation
program will start automatically.

Alternatively, select Start -> Run, and type D:\setup (D, being your CD-ROM drive).

The Install Shield Wizard will start, and guide you through the update of NodeManager.

The following menu will appear:

Select Repair, and click Next.

Finish the update following the on-screen instructions.
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Uninstalling NodeManager
Insert the NodeManager CD-ROM in your CD drive. If auto run is enabled, the installation
program will start automatically.

Alternatively, select Start -> Run, and type D:\setup (D, being your CD-ROM drive).

The Install Shield Wizard will start, and guide you through the uninstallation of NodeManager.

The following menu will appear:

Select Remove, and click Next.

Finish the uninstallation following the on-screen instructions.

Please note that any NodeManager Database(s) already made, will NOT be deleted by the
uninstallation.
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Ernitec Offices

Ernitec A/S (Headquarters)
Hørkær 24
DK-2730 Herlev
Denmark
Phone: +45 44 50 33 00
Fax: +45 44 50 33 33

ernitec@ernitec.dk
www.ernitec.com

Ernitec GmbH (German Branch Office)
Stormarnring 28
D-22145 Stapelfeld
Germany
Phone: (040) 67 56 25 0
Fax: (040) 67 56 25 25

ernitec@aol.com
www.ernitec.com

Ernitec UK (UK Branch Office)
Gerrard House
Worthing Road
East Preston
West Sussex BN16 1AW
England
Phone: 01903 77 27 27
Fax: 01903 77 27 07

sally@ernitec-uk.co.uk
www.ernitec.com

Ernitec France (French Branch Office)
No 29 Parc Club du Millénaire
1025 rue Henry Becquerel
F-34036 Montpellier cedex 1
France
Phone: 04 67 15 10 15
Fax: 04 67 64 01 81

ernitec@ernitec.fr
www.ernitec.com

Ernitec ME (Middle East Office)
Hamra - Makdesi Street
Younis Center - 5th floor
Office no. 503
P.O.Box 113/5721
Beirut
Lebanon
Phone: +961 1 751 796
Fax: +961 1 751 795

malek_kabrit@ernitecme.com
www.ernitecme.com
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Cable Suppliers

Belden Wire & Cable  (Europe Headquarters)
BWC - The Netherlands
Edisonstraat 9, Postbus 9
5928 PG Venlo, 5900 AA
The Netherlands
Phone: +31 77 387 8555
Fax: +31 77 387 8448

sales.info@belden.nl
www.belden.com

Anixter International Ltd.
Anixter House
1 York Road
UB8 1RN Uxbridge, Middelsex
United Kingdom
Phone: +44 1895 81 81 81
Fax: +44 1895 81 81 82

info@anixter.net
www.anixter.co.uk

Coferro A/S
Vesterlundvej 6
2730 Herlev
Denmark
Phone: +45 44 84 55 55
Fax: +45 44 84 67 06

coferro@coferro.dk
www.coferro.dk

Waschek Kabel GmbH
Heidenheimerstr. 64
89312 Günzburg
Germany
Phone: +49 8221 90 11 0
Fax: +49 8221 3 20 51

info@waschek.de
www.waschek.de

Eupen - Cable Division
Malmedyer Str. 9
4700 Eupen
Belgium
Phone: +32 87 597000
Fax: +32 87 597100

info@eupen.com
www.eupen.com
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Echelon Offices

Echelon Corporation (Headquaters)
415 Oakmead Parkway
Sunnyvale, CA 94085
USA 
Phone: +1-408-938-5200 or +1-888-ECHELON (324-3566)
Fax: +1-408-328-3800

lonworks@echelon.com
www.echelon.com

Echelon Asia Pacific Ltd. (Subsidiary)
Rooms 1708-09, 17th Floor
Shui On Center
6-8 Harbour Road
Wanchai 
Hong Kong 
Phone: +852 2802 3769
Fax: +852 2824 9296
apj@echelon.com 

Echelon China Corp. (Subsidiary)
Room 2103-2104
Beijing Huabin International Building No. 8
Yong An Dong Li
Jian Guo Men Wai 
China 100022 
Phone: +86 10 8528 8741 
Fax: +86 10 8528 8740 
lonworks@echelon.com.cn 
www.echelon.com.cn 

Echelon Europe Ltd. (Subsidiary)
16 The Courtyards
Hatters Lane
Watford 
Hertfordshire WD1 8YH
United Kingdom
Phone: +44 (0)1923 43 01 00
Phone: +44 (0) 1923 43 02 00 (technical support)
Fax: +44 (0)1923 43 03 00 
lonworks@echelon.co.uk (sales)
lonsupport@echelon.co.uk (support)

Echelon France, S.A.R.L. (Subsidiary)
Bat Venus, 2 Parc Club Ariane
Rue Helene Boucher
78284 Guyancourt 
France 
Phone: +33 1 30 48 9700
Fax: +33 1 30 57 5320 
jean@echelon.co.uk 
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Echelon GmbH (Subsidiary)
Hermann-Oberth-Strasse 17 
D-85640 Putzbrunn
Germany 
Phone: +49 89 456971 0 
Fax: +49 89 456971 71 
hhertel@echelon.de
lonworks@echelon.de (information)

Echelon Italy 
Largo Richini 6 
20122 Milano
Italy 
Phone: +39 2 58215 235 
Phone: +39 2 58215 237 (alternate)
Fax: +39 2 58215 760 
davide@echelon.co.uk 

Echelon Japan, K.K. (Subsidiary)
Yoyogi Yoshino Bldg., 2F, 
1-58-5 Yoyogi, Shibuya-ku
Tokyo 151-0053 
Japan
Phone: +81 3 3320 1288
Fax: +81 3 3320 1278
lonworks@echelon.co.jp
www.echelon.co.jp 

Echelon BV (Subsidiary) 
Printerweg 3
3821 AP Amersfoort
The Netherlands
Phone: +31 33 450 4070
Fax: +31 33 450 4079 
netherlands@echelon.co.uk 

Echelon Korea
#201, 27F
Korea World Trade Center
159, Samsung-dong, Kangnam.Ku
135-729 Seoul
Korea
Phone: +82 2 551 2783
Fax: +82 2 551 2710 
info@echelon.co.kr
http://www.echelon.co.kr
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Echelon Worldwide Distributors

Argentina

ELKO S.R.L.
Av. Belgrano 1661
1093 Buenos Aires
Argentina 
Contact: Mr. Hector Musarra 
Phone: +54 1 476 1101
Fax: +54 1 325 8819

Australia  

9-10 Bastow Place 
Mulgrave, VIC 3170
Australia 
Contact: Stephen Tang 
Phone: +61 3 9574 9300 
Fax: +61 3 9574 9773
Web: www.veltek.com.au 

Level 5,4 Belmore Street 
Burwood, NSW 2134
Australia 
Contact: Mr. Ian Mackereth 
Phone: +61 2 745 1400 
Fax: +61 2 745 1401 
Web: www.veltek.com.au 

Arrow Australia Electronics Pty. Ltd.

Belgium

EBV Elektronik 
Excelsior Laan 
35 1930 Zaventem
Belgium 
Contact: Mr. Rudi van Parijs 
Phone: +32 2 720 0010 
Fax: +32 272 081 51 

China 

Beijing VATON 
Friendship Hotel, Bldg 5, Rm 50330 
Beijing 100873 
P.R. China 
Contact: Mr. Jiangning Sheng 
Phone: +86 10 6849 8440 
FAX: +86 10 6849 8723
http://www.vaton.com.cn 

Chong Qing Chuanyi Building Automation Co. Ltd. 
9/F, Chuanyi Building 
Bei Bei District, Chongqing City 
Sichuan Province 
P.R.China
Contact: Ms. Li Xia 
Fax: +86 23 68865340 

Harbin S&T Network Technology Co., 
Ltd. 22/F Press Plaza
399 Youyi Road, Daoli District 
Harbin, Heilongjiang 150010 
P.R. China 
Contact: Mr. Zhijie Zhao 
Phone: +86 451 4890 998
Fax: +86 451 4890 997
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Hong Kong Smartech Control Systems Ltd.
Suite 1206, 12/F., Kodak House Two
39 Healthy Street East
North Point,Hong Kong
Contact: Ms. Anna Law
Phone +852 2516 5080 
Fax +852 2516 5015

Shanghai Colleges and Universities Instrument and Equipment Co., Ltd. 
100 Guilin Road 
Shanghai 200234 
P.R. China 
Contact: Mr. Limin Zhao 
Phone: +86 21 6432 3365
Fax: +86 21 6432 1584

VSTAR Communication and Control Technology Co., Ltd. 
Guangdong Pumped Storage Tower, Suite 1006 
32 East Longkou Road, Tianhe District 
Guangzhou, Guangdong 510630 
P.R. China 
Contact: Mr. George Liu
Phone: +86 20 8751 8168 x 81006
Fax: +86 20 8754 7385

Xi'an Intellicom Technology Ltd.
EF 13/F, Tower B, Torch Bldg., Development Zone for Hi-Tech Industry 
Xi'an, Shaanxi 710075 
P.R. China 
Contact: Mr. Hui Cai 
Phone: +86 29 821 1982 
Fax: +86 29 822 3724

Denmark 

EBV Denmark 
DK-2860 Søborg (København) 
Rosenkaeret 11 C
Denmark
Contact: Ole Bugtrup 
Phone: +45 (0) 39 69 05 11 
Fax: +45 (0) 39 69 05 04
Web: http://www.ebv.com 

Eastern Europe 

EBV Eastern Europe 
Diefenbachgasse 35/1 
A-1150 Wien
Austria
Contact: Slobodan Puljarevic  
Phone: + 43 1 89 152 16 
Fax: +43 1 89 152 20
Web: http://www.ebv.com
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Finland 

EBV Finland 
Pihatörmä 1A 
FIN-02240 Espoo 
Finland 
Contact: Timo Juvonen 
Phone: +358 (0) 9 2705 2790 
Fax: +358 (0) 9 2709 5498
Web: http://www.ebv.com 

EBV Finland 
Nahkatehtaankatu1
FIN-90100 Oulu
Finland 
Contact: Lasse Laitinen 
Phone: +358 (0) 8 5624910 
Fax: +358 (0) 8 5624915 
Web: http://www.ebv.com 

France 

EBV France 
F-92184 Antony Cedex 
3, rue de la Renaissance
France 
Contact: Philippe Bendet
Phone: +33 (0)1 40 96 30 19
Fax: +33 (0)1 46 66 50 41
Web: http://www.ebv.com 

Germany 

EBV Elektronik 
Ammerthalstraße 28 
D-85551 Kirchheim-Heimstetten
Germany 
Contact: Mr. Franz Wiedemann 
Phone: +49 89 991 14 0 
Fax: +49 89 991 14 424 
Web: http://www.ebv.com 

India

Advanced Micronic Devices 
No. 101, 15th Cross 
2nd Block, Jayanagar 
Bangalore 560 011
India 
Contact: Mr. K. Vijaya Raghavan
Phone: +91 80 656 5610 or +91 80 656 5611
Fax: +91 80 656 6249
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Italy

EBV Italy 
F-92184 Antony Cedex 
3, rue de la Renaissance
France 
Contact: Philippe Bendet
Phone: +33 (0)1 40 96 30 19
Fax: +33 (0)1 46 66 50 41
Web: http://www.ebv.com 

Japan

MACNICA, Inc.
Hakusan High-tech Park, 1-22-2 Hakusan
Midori-ku, Yokohama-city
226-8505 Japan
Contact: Product Marketing Dept. 1 
Haruki Watanabe or Yasuhito Kojima 
Phone: +81 45 939 6116
Fax: +81 45 939 6117
Web: http://www.macnica.co.jp 

MIDORIYA ELECTRIC CO., LTD.
Syuzui Building, 2-7-19 Kyobasi
Chuo-ku, Tokyo
104-8307 Japan
Contact:Takuya Hitomi
Phone: +81 3 3561 3871
Fax: +81 3 3561 7914
Web: http://www.midoriya.co.jp/lonworks/shige.html

WADA ELECTRIC CO., LTD.
3-1-11 Ohiraki, Fukushima-Ku
Osaka-City, Osaka
553-0007 Japan
Contact: Hideki Nakao
Phone: +81 6 6462 1134
Fax: +81 6 6462 9901
Web: http://www.wada-elec.co.jp

TOSHIBA INFORMATION SYSTEMS CORP.
Kawasaki Nisshincho Building
7-1 Nisshincho, Kawasaki-ku
Kawasaki City, Kanagawa 
210-8540 Japan
Contact:Makoto Oguma
Phone: +81 44 200 5428
Fax: +81 44 200 5970
Web: http://www.tjsys.co.jp
e-mail: lonworks@tjsys.co.jp
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Korea 

Mat Co., Ltd. 
#864-3, Kwanyang-Dong 
Dongand-Ku Anyang-Si 
Kyunggi-Do, Korea 431-060 
Phone: +82 343 22 6223 
Fax: +82 343 22 6226 

Malaysia

Bluefin Technologies Sdn. Bhd. 
No. 38 Ground Floor
Jalan Dewan Sultan Sulaiman1
50300 Kuala Lumpur
Malaysia
Contact Person: Mr. Andrew Wong Yee Kong 
Fax: +60 3 2693 5189
Tel: +60 3 2692 8505

The Netherlands 

EBV Elektronik 
Planetenbaan 116 
NL-3606AK Maarssenbroek
The Netherlands 
Contact: Johan Evers
Phone: +31 346 583027 
Fax: +31 346 583025
Web: http://www.ebv.com 

Norway 

EBV Norway 
N - 0612 Oslo 
P.B. 101, Manglerud
Norway 
Contact: Vidar Lillehagen 
Phone: +47 22671780 
Fax : +47 22671789 

Singapore

GEIC
(General Electronics & Instrumentation Corp. Pte Ltd)
Systems Division Blk 1008
Toa Payoh North
#04-08 Singapore 318996 
Contact: Mr. Goh Eng Huay
Phone: +65 354 8670 
Fax: +65 353 2261
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Slovakia

EBV Slovakia
CZ - 180 00 Praha 
8 V Holesovickach 29
Slovakia
Contact: Peter Mariassy
Phone: +420 (0) 2 900 22 101/2
Fax : +420 (0) 2 688 90 78
Web: http://www.ebv.com

Spain 

EBV Spain 
E-28760 Tres Cantos Madrid 
Ronda de Poniente, 4. Ala Derecha. 
Centro Empresarial Euronova 1a planta. 
Oficina A.
Spain 
Contact: Antonio Fernandez 
Phone: +34 (9) 1 804 32 56
Fax: +34 (9) 1 804 41 03
Web: http://www.ebv.com 

South Africa

Inala Identification & Control
Inala House 
127 - 15th Road 
Randjespark 
Midrand, 1685 
South Africa
Contact: Stef du Plessis
Phone +27 11 254 8424 
Fax +27 11 254 8333 

Sweden 

EBV Elektronik 
Sjöängsvägen 17 
S-192 72 Sollentuna 
Sweden 
Contact: Mr. Ulf Meition 
Phone: +46 8 59 47 02 30
Fax: +46 8 59 47 02 31
Web: http://www.ebv.com 

Switzerland 

EBV Elektronik 
Bernstrasse 394 
Dietikon 8953 
Switzerland 
Contact: Mr. Fritz Kurt 
Phone: +41 1 745 61 61
Fax: +41 1 745 61 00
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Taiwan 

AExcel Technology 
9F-1, No. 79, Sec. 1, Hsin Tai Wu Road,
Hsi-Chih Taipei, Taiwan 
Contact: Roger Tseng
Phone: +886 2 2698 9301 
Fax: +886 2 2698 1798 

Wei Keng Industrial Co., Ltd.
2F 34, Sec 1, Huan Shan Road 
Nei Hu, Taipei 114, 
Taiwan 
Contact: Mr. Mingsong Su
Phone: +886 2 2659 0202
Fax: +886 2 2658 0959

Turkey 

EBV
Bayar Cad. Gulbahar Sok. No. 17
Perdernsac Plaza D. 131-132
Kozyatagi, 81090 / Istanbul
Turkey 
Sales: Kamil Pakkan & Didern Suer
Tech Support: Sefik Sahingoz
Phone: +90 216 463 1352 / +90 216 463 1353
Fax: +90 216 463 1355
Web: http://www.ebv.com 

United Kingdom 

EBV Elektronik UK
12 The Interface Business Park 
Bricknoll Lane, Wooton Bassett 
Wiltshire SN4 8SY
United Kingdom 
Contact: Paul Robinson 
Phone: +44 1793 849 933 (direct 01793 859 511)
Fax: +44 1793 859 555
Web: http://www.ebv.com 

United States

Engenuity Systems Inc.
1600 W. Chandler Blvd
Suite 250
Chandler, AZ 85224
Contact: Jodi Jones
Phone: (480) 782-5600 or (800) 375-3363
Fax: 480-782-5601 
Web: http://www.engenuity.com
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